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Вступ 

Використання сучасних технологій у проектуванні систем 

автоматизації є невід’ємною частиною виконання проектних 

робіт. Такий підхід сприяє підвищенню ефективності вирішення 

задач пов’язаних з розрахунками, конструюванням та 

виготовленням проектної документації. Дані методичні вказівки 

до виконання лабораторних робіт з навчальної дисципліни 

«Проектування систем автоматизації» місять необхідний 

матеріал для засвоєння студентами початкових практичних 

навиків проектування систем автоматизації, а також 

допомагають навчитися використовувати сучасні програмні 

продукти для виконання розрахунків, моделювання, 

випробування та підготовки конструкторської документації у 

відповідності до державних стандартів.    

У лабораторних роботах розглянуто особливості 

застосування систем автоматизованого проектування (AutoCAD, 

Autodesk Inventor, Компас-3D) для розробки 3D-моделей та 

збірних конструкцій пристроїв та систем автоматизації, 

монтажних та складальних одиниць. Перша лабораторна робота, 

дає змогу навчитися використовувати програму AutoCAD  для 

розробки 3D-моделей (1 ак. год.), друга розкриває можливості 

застосування програми Autodesk Inventor у проектуванні збірних 

конструкцій та складальних одиниць (2 ак. год). Третя 

лабораторна робота (3 ак. год) допомагає навчитися розробляти 

3D-моделі та збірні конструкції за допомогою програми Компас-

3D.   
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Лабораторна робота №1 

Тема: Розробка 3D-моделей при проектуванні елементів 

систем автоматизації 

Мета: Навчитися виконувати 3D-моделі елементів систем 

автоматизації використовуючи програму AutoCAD. 

 

Теоретичні відомості 

Способи побудови 3D-об’єктів. Площина екрану у програмі 

AutoCAD збігається з площиною XY світової системи координат 

вона називається площиною побудов. Будуючи двовимірні 

об’єкти, можна змінювати їх рівень, тобто керувати 

переміщенням площини побудов вздовж осі Z. Спостерігати за 

зміною рівня площини можна при переході до ізометричних 

видів. Змінити рівень площини побудови можна введенням 

додатного або від’ємного числа у поле Elevation (Уровень). 

Увівши значення 100, отримаємо зсув об’єкта вгору вздовж осі 

Z, від’ємне значення у полі призведе до зміщення об’єкта вниз 

вздовж осі Z.  

Один із найпростіших способів створення тривимірних 

об’єктів це –  витискання. Витисканням називається зміна 

властивості двовимірного об’єкта (товщина або висота). 

Виконати операцію можна, вибравши із контекстного меню 

об’єкта команду Properties (Свойства) і змінивши значення у 

полі Thickness (Высота 3D). 

Вводити можна як додатне так і від’ємне значення. У 

першому випадку об’єкти видтискаються вздовж додатного 

напрямку осі Z, в другому вздовж від’ємного (рис. 1.1). На 

криволінійній частині об’єктів система виводить деяку кількість 

твірних ліній. 

До об’єктів утворених таким способом можна застосувати 

команду _hide (Скрыть), щоб приховати невидимі лінії. 

Витискання полілінії прямокутника створює об’єкти з 

«непрозорими» боковими стінками. 

Тривимірні об’єкти в AutoCAD можна представити 

каркасами, поверхнями і твердотілими моделями. Каркасні 

моделі представлені лише ребрами граней являють собою 

прозорі об’єкти. Створюється каркасна модель командами 
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побудови двовимірних графічних примітивів, до яких належать 

відрізки, точки, кола, дуги тощо, але при цьому задавати 

потрібно тривимірні координати точок X, Y, Z. 

 

 
Рис. 1.1. Побудова 3D-об’єкта «Выдавливанием» 

 

Поверхні мають непрозорі грані але порожні всередині, 

представлені оболонкою без наповнення. Такі поверхні можуть 

представлятися не лише ребрами, вони мають також непрозорі 

грані. Крім того, поверхня може бути представлена сіткою, 

тобто низкою послідовно розташованих граней, що мають 

спільні ребра. 

Твердотільний об’єкт – суцільний, має об’єм і масу. За 

допомогою відповідних команд у AutoCAD можна створити 

поверхні таких типів: 

1. 3DFACE (3DГРАНЬ) будує тривимірну грань, яка 

задається трьома або чотирма ребрами. 

2. 3DMESH (3DСЕТЬ) будує сітку з чотирикутників, 

вершини яких потрібно задати. 

3. PFACE (ПГРАНЬ) будує багатогранну сітку, для якої 

задаються вершини і вказуються грані до яких вони належать. 

4. EDGESURF (П-КРОМКА) будує поверхню Кунса, 

обмежену чотирма криволінійними або прямими ребрами. 

5. RULESURF (П-СОЕД) утворює сітку, що з’єднує два 

криволінійні або прямі ребра. 

6. REVSURF (П-ВРАЩ) утворює поверхню обертання 

шляхом обертання двовимірного об’єкта навколо осі. 
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7. TABSURF (П-СДВИГ) утворює поверхню шляхом 

переміщення двовимірного об’єкта в заданому напрямку. 

Тривимірна грань (3DMesh). Способи введення команди: 

- набрати з клавіатури команду _3dmesh (3DСЕТЬ); 

- натиснути кнопку  на панелі інструментів (відсутня у 

інтерфейсі панелей інструментів за замовчуванням, 

налаштовується через пункт Customize (Адаптация)). 

Команда 3DMESH (3DСЕТЬ) будує довільну незамкнену сітку з 

чотирикутників, вершини яких потрібно задати. Використання 

команди дозволяє побудувати сітку складної конфігурації. 

Команда видає запит на розмір сітки в напрямках М (Enter size 

of mesh in M direction (Размер сети в направлении M)), який 

ближче до горизонтального  напрямку (вісь Х у XY-площині) і 

N (Enter size of mesh in N direction (Размер сети в направлении 

N)), який ближче до вертикального напрямку (вісь Y у XY-

площині). У відповідь потрібно ввести число в діапазоні від 2 до 

256. Далі видаються запити щодо координат точок (вершин). 

Приклад побудови сітки з М = 4, N = 3 показано на рис. 1.2. 

Рис. 1.2. Приклад побудови сітки командою _3DMESH 

(3DСЕТЬ) 

 

Поверхня переміщення (Tabsurf). Способи введення команди: 

- набрати з клавіатури команду: _tabsurf (П-СДВИГ); 
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- викликати з меню: Draw>Modeling>Meshes> Tabulated Mesh 

(Рисование > Моделирование > Сети > Сеть сдвига) – 

класичний AutoCAD; 

- натиснути кнопку  на панелі інструментів Mesh > 

Primitives (Сеть > Примитивы). 
Команда TABSURF утворює поверхню шляхом переміщення 

двовимірного об’єкта в заданому напрямку. Об’єкт 

переміщення задається відрізком, дугою, поліллінією. Напрямок 

переміщення задається відрізком або незамкненою полілінією. 

Вектором, що задає напрям і відстань зсуву може бути відрізок 

або розімкненена полілінія (2D, 3D). Створена сітка є набором 

многокутників з паралельними направляючому вектору 

сторонами. І визначальна крива і вектор повинні існувати на 

рисунку до моменту виклику команди (рис. 1.3): 

Рис. 1.3. Приклад побудови 3D-сітки командою _TABSURF (П-

СДВИГ) 

 

Поверхня обертання (Revsurf). Способи введення команди: 

- набрати з клавіатури команду: _revsurf (П-ВРАЩ); 

- викликати з меню: Draw>Modeling>Meshes> Revolved Mesh 

(Рисование > Моделирование > Сети > Сеть вращения) – 

класичний AutoCAD; 

- натиснути кнопку  на панелі інструментів Mesh > 

Primitives (Сеть > Примитивы). Поверхня утворюється 

обертанням вибраного об’єкта навколо заданої осі. 

Об’єктом обертання можуть бути відрізок, дуга, полілінія 
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тощо. Вісь задається відрізком або кінцевими точками 

незамкненої полілінії. Об’єкт можна повернути на повний кут 

360˚ або на заданий кут. 

Команда дозволяє вибрати початкове значення кута і задати 

значення кута повороту. Додатне значення кута задається проти 

годинникової стрілки. Розмір сітки поверхонь обертання 

визначається значенням системних змінних SURFTAB1 і 

SURFTAB2. 

Побудова 3D-тіл. 3D-тіла можна будувати на базі 

елементарних форм: паралелепіпедів, конусів, циліндрів, сфер, 

торів і клинів, а також шляхом витиснення 2D-об’єктів або 

обертання їх довкола осі. Складні просторові тіла створюються 

шляхом комбінування елементарних. Елементарні форми можна 

об'єднувати, віднімати і перетинати (тобто брати тільки спільну 

займану декількома тілами частину об'єму). 

Подальша модифікація тіл здійснюється шляхом спряження 

їх граней і зняття фасок. Підтримується ряд функцій, пов’язаних 

з редагуванням граней тіл, що не потребує побудови додаткових 

геометричних об’єктів і виконання логічних операцій. В 

AutoCAD також є команди, за допомогою яких тіло можна 

розрізати на дві частини або здійснити розріз площиною. 

Густина ліній кривизни, що використовуються для 

візуалізації криволінійних елементів моделі, визначається 

системною змінною ISOLINES. Системна змінна FACETRES 

задає ступінь згладжування тонованих об’єктів з усуненими 

невидимими лініями. 

Паралелепіпед (Box). Способи введення команди: 

- набрати з клавіатури команду: _box (ЯЩИК); 

- викликати з меню: Draw > Solids > Box (Рисование > 

Моделирование > Ящик) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Box (Фигура > Примитив > Ящик).  

Паралелепіпед визначається точками кутів основи 

паралелепіпеда і висотою або центром, висотою і трьома 

розмірами – довжиною, шириною, висотою. Основа 

паралелепіпеда завжди паралельна площині XY поточної UCS 

(ПСК). 
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Конус (Cone). Способи введення команди: 

- набрати з клавіатури команду: _cone (КОНУС); 

- викликати з меню: Draw > Modeling > Cone (Рисование > 

Моделирование > Конус) – класичний AutoCAD; 

- натиснути на кнопку  панелі інструментів Solid > Primitive 

> Polysolid > Cone (Фигура > Примитив > Политело > 

Конус). 
Конус будується з еліптичною або круговою основою і 

визначається положенням центра, радіусом основи і висотою. За 

умовчанням основа конуса розташовується в площині XY 

поточної UCS (ПСК). Висота конуса (може бути як додатною, 

так і від’ємною) паралельна до осі Z. Положення вершини 

конуса визначає його висоту і орієнтацію. За замовчуванням 

висота перпендикулярна основі. Змінити орієнтацію конуса 

можна, якщо вибрати опцію Axis endpoint (Конечная точка оси) 

і задати координати вершини конуса. 

Для побудови зрізаного конуса, або конуса орієнтованого під 

певним кутом потрібно скористатись опцією Top radius (Радиус 

верхнего основания) або спочатку намалювати круг, а потім 

командою видавлювання виконати витиснення зі звуженням під 

кутом до осі Z. 

Піраміда (Pyramid). Способи введення команди: 

- набрати з клавіатури команду _pyramid (ПИРАМИДА); 

- викликати з меню: Draw > Modeling > Pyramid (Рисование > 

Моделирование > Пирамида) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Polysolid > Pyramid (Фигура > Примитив > 

Политело > Пирамида). 
За замовчуванням піраміда визначається за центром базової 

точки, точкою посередині кромки і точкою, яка задає висоту. 

Циліндр (Cylinder). Способи введення команди: 

- набрати з клавіатури команду: _cylinder (ЦИЛИНДР); 

- викликати з меню: Draw > Modeling > Cylinder (Рисование > 

Моделирование > Цилиндр) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 
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Primitive > Cylinder (Фигура > Примитив > Цилиндр). 

Основа циліндра може бути круговою або еліптичною, 

розташовується в площині XY поточної UCS (ПСК). Для 

побудови циліндра необхідно визначити положення центра 

основи, радіус або діаметр основи. Висота циліндра задається 

введенням конкретного значення. 

Сфера (Sphere). Способи введення команди: 

- набрати з клавіатури команду: _sphere (СФЕРА); 

- викликати з меню: Draw > Modeling > Sphere (Рисование > 

Моделирование > Сфера) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Sphere (Фигура > Примитив > Сфера). 

Сфера будується після визначення положення центра і 

радіуса. Основа кулі розташовується в площині XY поточної 

UCS (ПСК). 

Тор (Torus). Способи введення команди: 

- набрати з клавіатури команду: _torus (ТОР); 

- викликати з меню: Draw > Modeling > Torus (Рисование > 

Моделирование > Тор) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Polysolid > Torus (Фигура > Примитив > 

Политело > Тор). 
Твердотілий тор має центр на початку координат і вісь 

паралельну осі Z. Площина XY поточної UCS (ПСК) ділить тор 

на дві рівні частини в подовжньому перетині. Тор будується 

після визначення положення центра, радіуса кола, що проходить 

через центр труби і радіуса труби. 

Клин (Wedge). Способи введення команди: 

- набрати з клавіатури команду: _wedge (КЛИН); 

- викликати з меню: Draw > Modeling > Wedge (Рисование > 

Моделирование > Клин) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > 

Primitive > Polysolid > Wedge (Фигура > Примитив > 

Политело > Клин). 
Основа клину паралельна площині XY поточної UCS (ПСК), а 
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похила грань розташовується напроти першого вказаного кута 

основи. Висота клина (може бути як додатною, так і від’ємною) 

паралельна до осі Z. Ребро похилої грані орієнтоване вздовж осі 

Х. Для побудови клину потрібно задати координати двох 

протилежних вершин основи і висоту. Вибір опції Length 

(Длина) дозволить задати три розміри: Length – довжину вздовж 

осі Y, Width – ширину вздовж осі Х, Height – висоту вздовж осі 

Z. Опція CEnter призначена, щоб задати центр клину. Центром 

клину є центр похилої грані. 

Створення 3D-тіл з двовимірних об’єктів. 3D-тіла можна 

створювати шляхом витиснення двовимірних об’єктів (тобто 

надання їм висоти) за допомогою команди EXTRUDE 

(ВЫДАВИТЬ). Витиснення можна застосовувати до таких 

замкнутих кривих, як полілінії, многокутники, прямокутники, 

кола, еліпси, замкнуті сплайни, кільця і області. Неможливо 

витиснути: тривимірні об’єкти, що входять в блоки, розімкнені 

полілінії і полілінії з сегментами, що перетинаються. Напрям 

витиснення визначається траєкторією або заданням глибини і 

кута. 

Витискання (Extrude). Способи введення команди: 

- набрати з клавіатури команду: _extrude (ВЫДАВИТЬ); 

- викликати з меню: Draw > Modeling > Extrude (Рисование > 

Моделирование > Выдавить) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > Solid 

> Extrude (Фигура > Фигура > Выдавить). 

Витискання здійснюється перпендикулярно до площини 

об’єкта або вздовж заздалегідь заданої траєкторії. Можна 

задавати кут конусності, під яким сторони тіла будуть 

звужуватись. Від’ємне значення кута призводить до розширення 

сторін. 

Об’єкт, що витискається може бути областю, колом, 

прямокутником кільцем, замкненою полілінією. Траєкторія 

вздовж якої витискається об’єкт, повинна належати одній 

площині і може бути відрізком, полілінією, дугою. Але об’єкт і 

траєкторія не повинні належати одній площині. 

Команда EXTRUDE (ВЫДАВИТЬ) часто використовується 
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для отримання моделей складних об’єктів такі, як шестерні або 

зірочки. Особливо зручна ця команда для об’єктів, що мають 

спряження, фаски і аналогічні елементи, які важко відтворити 

без використання витиснення перетинів. 

Обертання (Revolve). Способи введення команди: 

- набрати з клавіатури команду: _revolve (ВРАЩАТЬ); 

- викликати з меню: Draw > Modeling > Revolve (Рисование > 

Моделирование > Вращать) – класичний AutoCAD; 

- натиснути на кнопку  на панелі інструментів Solid > Solid 

> Revolve (Фигура > Фигура > Вращать). 

Тривимірний об’єкт утворюється з двовимірного обертанням 

навколо заданої осі. Двовимірний об’єкт може бути областю, 

колом, еліпсом багатокутником, замкненою полілінією або 

замкненим сплайном. Неможливо застосувати обертання до: 

тривимірних об’єктів; які входять в блоки; розімкнутих 

поліліній і поліліній з сегментами, що перетинаються. 

Тіла можна створювати шляхом обертання замкнутих 

об’єктів на заданий кут довкола осі X або Y поточної UCS 

(ПСК). Крім того, об’єкт можна обертати довкола відрізка, 

полілінії або двох заданих точок. Подібно до команди 

EXTRUDE, цю команду зручно застосовувати для об’єктів, що 

мають спряження і інші аналогічні елементи. 

Вісь обертання вказується одним із методів: 

- Specify start point for axis of revolution (Начальная точка оси 

вращения) – задаються координати двох точок, початкової і 

кінцевої, що належать осі; 

- Опція Object (Объект) – вибирається відрізок або фрагмент 

полілінії; 

- Опція X/Y/Z: – віссю вибирається додатний напрям осі Х, Y 

або Z поточної системи координат. 

Після визначення об’єкта обертання і осі вводиться довільне 

значення кута повороту об’єкта. 

Побудова складних 3D-тіл. AutoCAD дозволяє будувати 

3D-тіла складної форми, застосовуючи об’єднання, віднімання і 

перетин вже побудованих тіл. 

Об’єднання (Union). Способи введення команди: 
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- набрати з клавіатури команду: _union (ОБЪЕДИНЕНИЕ); 

- викликати з меню: Modify > Solid editing > Union 

(Редактировать > Редактирование тела > Объединение) – 

класичний AutoCAD; 

- натиснути кнопку  на панелі інструментів Solid > Boolean 

> Union (Фигура > Логические операции > Объединение). 

За допомогою цієї команди можна побудувати складний 

об’єкт, що займає сумарний об’єм всіх його складових. 

Віднімання (Subtract). Способи введення команди: 

- набрати з клавіатури команду: _subtract (ВЫЧИТАНИЕ); 

- викликати з меню: Modify > Solid editing > Subtract 

(Редактировать > Редактирование тела > Вычитание) – 

класичний AutoCAD; 

- натиснути кнопку  на панелі інструментів Solid > Boolean 

> Subtract (Фигура > Логические операции > Вычитание). 

За допомогою команди SUBTRACT можна видалити з тіл ті 

частини, які також належать іншій множині. Цю команду, 

можна застосувати для отримання отворів в механічних деталях 

шляхом віднімання циліндрів. 

Перетин (Intersect). Способи введення команди: 

- набрати з клавіатури команду: _intersect (ПЕРЕСЕЧЕНИЕ); 

- викликати з меню: Modify > Solid editing > Intersect 

(Редактировать > Редактирование тела > Пересечение) – 

класичний AutoCAD; 

- натиснути кнопку  на панелі інструментів Solid > Boolean 

> Union (Фигура > Логические операции > Пересечение). 

За допомогою команди INTERSECT можна побудувати 

складне тіло, що займає об'єм, загальний для двох або більш 

перетинних тіл. Неперетинні частини об'ємів при цьому 

видаляються з креслення. 

Редагування тривимірних тіл. В AutoCAD є різні засоби 

зміни форми об’ємних тіл та їх відображення. Техніка 

редагування твердотільних 3D-об’єктів передбачає зняття 

фасок, спряження, побудову перетинів і розділення на частини. 

Для редагування тривимірних об’єктів також можна 
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застосовувати команди, які використовуються для редагування 

2D-тіл. 

Спряження граней 3D-тіл виконується за таким алгоритмом: 

1. Задати у командному рядку команду _fillet 

(СОПРЯЖЕНИЕ), обрати з меню класичного AutoCAD пункт 

Modify > Fillet (Редактировать > Сопряжение) або натиснути в 

панельному меню Home > Modify (Главная > Редактирование) 

на кнопку . 

2. Вибрати ребро тіла для спряження (верхнє коло на рис. 

1.4). 

3. Задати радіус спряження. 

4. Продовжити вибір ребер або натиснути ENTER для 

переходу до побудови спряження. 

 

 
Рис. 1.4. Приклад побудови спряження граней 3D-тіла 

 

Зняття фасок у 3D-тілах за таким алгоритмом: 

1. Задати у командному рядку команду _chamfer (ФАСКА), 

обрати з меню класичного AutoCAD пункт Modify > Chamfer 

(Редактировать > Фаска) або натиснути в панельному меню 

Home > Modify (Главная > Редактирование) кнопку . 

2. Вибрати ребро базової грані для фаски (ребро верхньої 

грані рис. 1.5). AutoCAD підсвічує одну або дві грані, суміжні з 

вибраним ребром. 

3. Для переходу до наступної грані ввести N (опція Next 

(Следующая)). Для підтвердження роботи з поточною 
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виділеною гранню натиснути ENTER. 

4. Задати довжину фаски для базової грані. Довжина фаски 

для базової грані вимірюється від вибраного ребра до точки на 

базовій грані. 

5. Задати довжину фаски для суміжної грані. Довжина фаски 

для суміжної грані вимірюється від вибраного ребра до точки на 

суміжній грані. 

6. Вказати ребра, на яких необхідно зняти фаски. 

 

Рис. 1.5. Приклад побудови фаски граней 3D-тіла 

 

Приклад створення 3D-моделі у програмі AutoCAD. На 

початку побудови 3D-моделі необхідно створити новий файл 

креслення. Це можна зробити за допомогою вибору команди з 

меню File > New (Файл > Создать). У вкладці «Выбор 

шаблона» можна вибрати один зі шаблонів, у нашому випадку 

це може бути acadiso3d. У якості прикладу використано 3D 

деталь з розмірами, які вказані на рис.1.6. 
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Рис.1.6. Зовнійшні вигляд деталі з розмірами  

 

Для початку роботи з 3D-об’єктами необхідно у вкладці 

«Рабочее пространство» встановити режим для роботи з 

тілами і поверхнями у трьохвимірному просторі «3D 

моделирование». На панельному меню у вкладці моделювання 

вибираємо «Ящик» і відкладаємо довжину, ширину і висоту 

нижньої частини деталі, як зображено на рис. 1.7. 

 

 
Рис.1.7. Побудова ширини і висоти основи деталі 

 

Далі будуємо верхній конус деталі. Для цього на панельному 

меню у вкладці «Моделирование» вибираємо «Конус». 

Переходимо на площину, шукаємо цент прямокутника і 

починаємо побудову вказавши у спливаючому меню радіус і 

висоту конуса (рис. 1.8).  

За розмірами приведеними на рис. 1.6 потрібно задати 

верхню частину конуса діаметром 70. Для цього необхідно 

потягнути за маркер на вершині конуса і задати потрібний 
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радіус (рис. 1.9). 

У конусі маємо отвір діаметром 55 мм. Для його виконання 

потрібно вибрати «Круг» на вкладці «Редактирование» 

панельного меню. Поставити цент круга у цент верхньої 

вершини конуса і задати відповідний розмір (рис.1.10). 
 

 
Рис.1.8. Побудова верхнього конусу деталі 

 

 
Рис.1.9. Встановлення розміру верхньої частини конуса 

 

 
Рис.1.10. Виконання отвору у верхній частині конуса 
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За допомогою команди «Выдавить» на вкладці 

«Моделирование», вказавши напрям до низу і висоту прорізу у 

40 мм, задаємо шлях прорізу у конусі (рис.1.11). Після цього 

забираємо прорізаний циліндр із конуса. Для цього 

використовуємо команду «Вычитание» на вкладці панельного 

меню «Редактировать тело». Натискаємо на значок  на 

вкладці панельного меню та вказуємо фігуру з якої будемо 

проводити видалення, а після цього натискаємо Enter.  

Для візуального перегляду деталі можна змінити вид 

представлення на вкладці панельного меню «Вид», вибравши 

потрібний вид, як показано на рис.1.12. 

 
Рис.1.11. Встановлення напрямку прорізу 

 

 
Рис.1.12. Вибір виду представлення  

 

Наступним кроком є створення зрізів на нижній частині 
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фігури. Для цього потрібно вказати межі зрізу, за допомогою 

команди «Отрезок» на вкладці «Редактирование» панельного 

меню. А також прорізати отвори, діаметром 20 мм, за 

допомогою команди «Круг» на вкладці «Редактирование» 

(рис. 1.13). Потім по утвореному контурі потрібно обрізати 

фігуру, за допомогою команди «Витягивание» на вкладці 

«Моделирование». У результаті отримаємо фігуру, як на рис. 

1.14. 

 

 
Рис.1.13. Утворення зрізів на 

нижній частині фігури 

 
Рис.1.14. Завершення процесу 

зрізування 

 

Для виконання отвору внизу прямокутної основи, діаметром 

60 мм виконуємо ті ж самі дії, що і при побудові отвору у 

верхній частині конуса (див. рис. 1.10, 1.11). Вигляд виконаної 

фігури з отвором наведено на рис. 1.15. 

 

 
Рис. 1.15. Побудова отвору внизу прямокутної основи 
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На завершення потрібно прорізати ще один отвір діаметром 

10 мм і висотою 15 мм. Для цього необхідно виконати дії, які 

показано на рис. 1.10 та 1.11. У результаті виконання всіх 

побудов отримаємо 3D-модель, яка представлена на рис. 1.16. 

 

 
Рис. 1.16. Кінцевий вигляд виконання 3D моделювання 

 

Програма роботи 

1. Ознайомитися з принципами та правилами побудови 

тривимірних елементів у 3D просторі програми AutoCAD. 

2. За заданим варіантом виконати побудову 3D-деталі з 

відповідними розмірами.  

 

Порядок виконання роботи 

1. Розглянути способи побудови 3D-об’єктів та приклад 

створення 3D-моделі у програмі AutoCAD з теоретичних 

відомостей. 

2. Вибрати 3D-деталь згідно варіанту з Додатку 1.  

3. Виконати побудову 3D-деталі аналогічно до прикладу, 

який описаний у теоретичних відомостях. 

4. Результати проектування оформити у вигляді звіту на 

стандартних аркушах формату А4, а також надати виконаний 

файл для перевірки. До звіті необхідно додати креслення 

розробленої 3D-деталі у трьох стандартних виглядах (спереду, 

збоку, зверху) та ізометрію (3D- модель) на аркуші 

стандартного розміру (А3-А1) з розмірами та заповненим 

основним написом. 
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Контрольні запитання. 

1. Опишіть способи побудови 3D-об’єктів у програмі 

AutoCAD. 

2. Як відбувається побудова 3D-тіл у програмі AutoCAD? 

3. Як відбувається створення 3D-тіл з двовимірних об’єктів у 

програмі AutoCAD? 

4. Як відбувається створення складних 3D-тіл у програмі 

AutoCAD? 

5.  Як відбувається редагування тривимірних тіл у програмі 

AutoCAD? 

6. Розкрийте особливість описаного прикладу створення 3D-

моделі у програмі AutoCAD. 
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Лабораторна робота №2 

Тема: Проектування збірних конструкцій 

Мета: Ознайомитися з особливостями проектування збірних 

3D-конструкцій у програмі Autodesk Inventor та розробити 

зборку деталей в її середовищі 

 

Теоретичні відомості 

Проектування збірних конструкцій з окремих складальних 

одиниці та поєднання їх у зборки є важливим етапом у 

проектуванні пристроїв та систем автоматизації. Розробляти 

складальні одиниці можна декількома методами, 

найпоширенішими з яких є: «знизу-вгору» і «згори-вниз». 

Метод «знизу-вгору» є найбільш традиційним способом 

створення збірних конструкцій (зборок). Він передбачає те, що 

спочатку кожна деталь створюється окремо в файлі, а потім ці 

деталі об’єднуються в підзборки, які у свою чергу, збираються в 

єдиний закінчений виріб. Цей метод відрізняється простотою і 

легкістю реалізації, дозволяє чітко вибудувати структуру 

головної зборки та всіх вузлів, які входять до її складу. При 

цьому, метод «знизу-вгору» дає дуже обмежені можливості по 

параметризації зборок, а редагування і внесення змін в такі 

моделі є складними. 

Метод проектування «згори-вниз» полягає в тому, що 

проектування починається з безпосереднього створення 

складальної одиниці, окреслення основних габаритів і великих 

вузлів та ін. Потім зі створених об’єктів утворюються окремі 

вузли і деталі, які опрацьовуються або в окремих файлах, або 

прямо в середовищі складальної моделі. Таке створення і 

редагування деталей і зборок називається контекстним, тобто 

робота над вузлами відбувається прямо в оточенні всіх інших 

складових частин зборки. 

Метод «згори-вниз» дозволяє легко створювати параметричні 

зборки. Оскільки деталі та вузли створюються прямо в 

складальній моделі, то їх кінцеве складання і взаємне 

розташування не потрібні. Однак, цей метод має певні недоліки, 

наприклад, виокремлення та перегрупування деталей між 

різними вузлами може призвести до помилок в моделях. 
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На практиці вкрай рідко користуються тільки одним методом 

проектування, зазвичай використовується їх комбінація. 

Наприклад, спочатку в зборці окреслюють корпусні деталі, які 

визначають габарити виробу, а потім за отриманими розмірами 

проектують складові частини в окремих деталях і зборках. 

Створення зборки в Autodesk Inventor відбувається у 

спеціальному середовищі роботи зі зборками, яке містить усі 

необхідні команди та операції. Для початку вибираємо з меню 

програми: Файл>Создать>Сборка. Після цього відкриється 

вікно зборки, яке не містить ніяких елементів (рис. 2.1).  

 

 
Рис. 2.1. Початкове вікно зборки 

 

Для додавання першої деталі зборки необхідно вибрати 

головну, або найбільшу деталь (елемент) зборки, яка 

залишатиметься нерухомою (рис. 2.2). Щоб вставити деталь, 

натискаємо кнопку «Вставить», яка знаходиться у верхньому 

лівому кутку робочого вікна та вибираємо базову деталь 

(наприклад, з попередньої лабораторної роботи). У деяких 

випадках для додавання деталей розроблених у інших 

програмах, наприклад таких, як AutoCAD необхідно виконати їх 

імпортування. Для цього потрібно скористатися панеллю 

«Начало работы» и кнопкою «Открыть», а у вкладці 

«Параметры открытия файла» вибираємо опцію «Импорт» і 

дотримуючись подальших вказівок системи виконуємо 
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імпортування розробленої деталі з інших програм. Для 

переміщення компонентів по простору зборки використовують 

звичайне захоплення мишею, або команди «Свободное 

пересещение» і «Свободный поворот». 
 

 
Рис. 2.2. Додавання першої деталі зборки 

 

Один з компонентів зборки обов’язково повинен бути 

базовим, тобто мати фіксоване положення. Це дозволить 

уникнути зайвих переміщень і дасть можливість знизити появу 

помилок у процесі побудови моделі. Для цього наведемо курсор 

миші на деталь та натиснемо «ПКМ», у спливаючому меню 

вибираємо «Базовый» (рис. 2.3). Якщо зборка складається з двох 

або більше однакових деталей, то їх можна скопіювати та 

розташувати поряд з базовою деталлю (рис. 2.4). 
 

 
Рис. 2.3. Формування базової моделі зборки 
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Рис. 2.4. Розташування деталі відносно базової 

 

У розглянутому прикладі дві однакові деталі будуть 

з’єднуватися за допомогою гумової прокладки між ними. Для 

створення гумової прокладки використовуємо метод «знизу-

вгору» виконавши послідовність: Файл>Cоздать>Деталь. 

Після цього відкриється вікно побудови зборки деталі. Далі 

необхідно створити ескіз проклади (рис. 2.5). 

 

 
Рис. 2.5. Побудова ескізу проклади 

 

Для створення 3D-моделі гумової прокладки переходимо на 

вкладку «3D-модель», вибираємо панель «Cоздать» 

>«Выдавливание». У вкладці «Расстояние» вибираємо 
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необхідну висоту деталі прокладка, у нашому випадку висота 

становить - 5 мм (рис. 2.6). 

 

 
Рис. 2.6. Побудова 3D-моделі з ескізу 

 

Для створення 4-х отворів болтового з’єднання визначаємо 

ескізний центр одного з отворів за допомогою функції «Точка». 

Вибираємо у «Дерево построєний» (панель ліворуч) необхідний 

«Эскиз2», потім вибираємо «Cоздать»>«Точка» (рис. 2.7, а). 

При цьому, розмір отворів та їх розташування визначаємо з 

отворів деталей, які будемо з’єднувати (наприклад, з 

попередньої лабораторної роботи). Далі вирізаємо наскрізний 

отвір за допомогою вкладки «3D-модель» панель «Изменить» > 

«Отверстие». У відповідному вікні обираємо потрібний діаметр 

отвору, у нашому випадку - 10 мм (рис. 2.7, б). 

Для сворення 3-х інших отворів використовуємо функцію 

«Прямоугольный массив». Вибираємо вкладку «3D-модель»> 

панель «Масив»>«Прямоугольный массив» (рис. 2.7, в). У вікні 

«Прямоуг. масив» вибираємо два напрямки розташування 

отворів та інтервал між ними.  

Для завершення створення прокладки потрібно обрати 

матеріал з якого вона виготовлена, це можна зробити за 

допомогою випадаючого меню та обрати матеріал «Резина», або 

будь який інший (рис. 2.8). 



28  

 
а 

 
б 

 
в 

Рис. 2.7. Процес створення отворів 
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Рис. 2.8. Вибір матеріалу деталі 

 

Для завершення підготовки деталей до зборки, створену 

гумову прокладку необхідно зберегти у ту ж папку де 

знаходиться базова деталь. Після збереження у зборку (дерево 

побудови) додається гумова прокладка у тій же послідовності 

(див. опис вище), що і інші деталі зборки (рис. 2.9). 

 

 
Рис. 2.9. Додавання деталей до зборки 

 

Для накладення складальних залежностей і обмежень та 

взаємного переміщення компонентів зборки в Autodesk Inventor 

існує дві команди: «Зависимость» і «Соединение». Різниця між 

ними полягає в тому, що за допомогою залежностей 
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накладаються геометричні обмеження між компонентами 

(поєднання площин, співвісність, розташування під кутом та 

ін.), а за допомогою з’єднань створюються реальні фізичні 

поєднання компонентів (вставка осі в отвір, шарнір, повзун 

тощо).  

У нашому випадку використовуємо команду «Зависимость». 

Для цього обираємо вкладку «Сборка» панель «Взаимосвязи»> 

«Зависимость» (рис. 2.10, а). Вибираємо першу точку, криву, 

грань або робочий елемент, при необхідності натискаємо 

«Выбор 1» - для активації можливості вибору (рис. 2.10, б). При 

потребі, вибираємо другий варіант кнопкою «Выбор 2» (рис. 

2.10, в). Для встановлення залежності натискаємо на кнопку 

«Применить» (рис. 2.10, г). 

 

 
а 
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Рис. 2.10. Використання команди «Зависимость» 
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Для вирівнювання гумової прокладки з базовою деталлю у 

меню «Зависимости в сборке» натискають на кнопку 

«Заподлицо» (рис. 2.11, а). Результат вирівнювання двох деталей 

зображено на рис. 2.11, б. 
 

   
а                                                      б 

Рис. 2.11. Результат вирівнювання двох деталей 
 

По аналогії проводять вирівнювання по осі Y (рис. 2.12, а) та 

створюють залежність другої деталі з гумовою прокладкою, яка 

розміщена на базовій деталі. У результаті отримаємо взаємне 

розташування всіх деталей зборки (рис. 2.12, б). 
  

  
   а                                                        б 

Рис. 2.12. Взаємне розташування всіх деталей 

 

Для того, щоб виконати болтове з’єднання цих деталей 

обирають вкладку «Вставка» > «Вставить из Библиотеки 

компонентов» (рис. 2.13). У розглянутому прикладі 
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використовують болт з діаметром різьби М10 та номінальною 

довжиною не менше 60 мм, гайку М10 та шайбу з внутрішнім 

діаметром 10 мм. 

Для з’єднання деталей за допомогою болтового з’єднання 

обирають вкладку «Взаимосвязи» > «Соединение» (рис. 2.14, а). 

Визначають першу точку, криву, грань або робочий елемент та 

при необхідності вибирають «Выбор 1», або «Выбор 2» (рис. 

2.14, б). Потім з’єднують обрані деталі. По аналогії з’єднують 

шайбу з геометрією отвору та гайку з різьбою (рис. 2.14, в). 
 

 
Рис. 2.13. Вибір елементів болтового з’єднання з «Библиотеки 

компонентов» 
 

 
а 
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Рис. 2.14. З’єднання деталей за допомогою болтового з’єднання 

 

Для того, щоб виконати з’єднання у інших 3-х отворах 

використовують функцію «Прямоугольный массив». Вибирають 

на вкладці «3D-модель» панель «Массив» > «Прямоугольный 

массив». У відповідному вікні потрібно обрати два напрямки 

розташування отворів та інтервал між ними (рис. 2.15). 
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Рис. 2.15. Побудова з’єднання всіх елементів 

 

Оскільки прокладка, яка знаходиться між двома деталями має 

тільки отвори під болтове з’єднання, а інші отвори відсутні, то 

необхідно відредагувати її так, щоб забезпечити повне 

співпадіння з елементами деталей. Для цього використовують 

функцію Autodesk Inventor - редагування деталей без їх 

окремого відкриття у новому вікні. Двічі клацаємо на моделі 

гумової прокладки та створюємо у ній новий ескіз (рис. 2.16). А 

за допомогою команди «Выдавливание» та режиму 

«Асиметрично» виконується витискання прокладки на 

необхідну відстань (рис. 2.17). 
 

 
Рис. 2.16. Редагування ескізу деталі «Прокладка» 
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Рис. 2.17. Редагування деталі «Прокладка» 

 

Для того, щоб деталь «Прокладка» зайняла остаточне 

положення створюємо отвір у ребрі прокладки. Цю дію 

виконуємо за допомогою ескізу отвору на бічному ребрі 

прокладки та подальшому застосуванні команди 

«Выдавливание», як це показано на рис. 2.18. Після виконання 

всіх побудов отримують кінцеву зборку, яка відображена на рис. 

2.19. 

 

 
Рис. 2.18. Ескіз для утворення наскрізного отвору 
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Рис. 2.19. Результат створення зборки 3-х деталей 

 

Розглянуті у даному прикладі особливості проектування 

збірних 3D-конструкцій дають змогу навчитися виконувати 

побудови різних за складністю зборок, як з використанням 

Autodesk Inventor так і інших подібних програмних продуктів, 

наприклад таких як SolidWorks, SolidEdge та ін. 

 

Програма роботи 

1. Ознайомитися з принципами та правилами побудови 

зборки елементів у програмі Autodesk Inventor. 

2. На основі приведеного у теоретичних відомостях 

прикладу процесу побудови збірних конструкцій виконати 

побудову зборки деталей за варіантом. 

 

Порядок виконання роботи 

1. Розглянути приклад створення зборки, який описано у 

теоретичних відомостях. 

2. Використовуючи 3D-деталь, що розроблена у попередній 

лабораторній роботі (за варіантом), виконати зборку деталей за 

розглянутою у теоретичних відомостях послідовністю: 

2.1. Для відкриття 3D-деталі, яка була розроблена у попередній 

лабораторній роботі необхідно у програмі Autodesk Inventor на 

вкладці «Начало работы» в меню «Открыть» вибрати файл 

розробленої раніше деталі, але замість натискання кнопки 



38  

«Открыть», на панелі відкриття файлу, натиснути кнопку 

«Параметры», а у закладці, що з’явиться «Параметри открытия 

файла» вибираємо «Импорт» і тільки після цього натискаємо на 

кнопку «Открыть» так, як показано на рис. 2.20. У наступному 

вікні натискаємо кнопку «Далее» залишаючи всі опції без змін, а 

після цього кнопку «Готово». У результаті ми зможемо 

продовжувати виконання процесу зборки, як це показано на рис. 

2.2. 

 
Рис. 2.20. Послідовність відкриття файлу 3D-деталі розробленої в 

AutoCAD у програмі Autodesk Inventor 
 

2.2. Створити копію деталі розробленої у попередній 

лабораторній роботі (див. рис. 2.4). 

2.3. Розробити у середовищі Autodesk Inventor 3D-модель 

гумової прокладки. 

2.4. Використовуючи болтове з’єднання з «Библиотеки 

компонентов» виконати повну зборку. 

3. Результати проектування оформити у вигляді звіту на 

стандартних аркушах формату А4, а також надати виконаний 

файл зборки для перевірки. До звіті необхідно додати креслення 

розробленої зборки у трьох стандартних виглядах (спереду, 

збоку, зверху) та ізометрію (3D- модель) на аркуші стандартного 

розміру (А3-А1) з розмірами та заповненим основним написом. 

 

Контрольні запитання. 

1. У чому суть методу проектування «знизу-вгору»? 
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2. У чому суть методу проектування «згори-вниз»? 

3. Як виконати додавання деталей розроблених у інших 

програмах у програму Autodesk Inventor? 

4. Як здійснюється переміщення компонентів по простору 

зборки? 

5. Як відбувається додавання деталей зборки? 

6. Яка особливість та способи використання функції 

«Прямоугольный массив»? 

7. Яка особливість створення болтового з’єднання?  

8. Як відбувається редагування деталей у вже готовій 

зборці? 



40  

Лабораторна робота №3 

Тема: Розробка монтажних креслень технічних засобів 

автоматизації 
Мета: Навчитись виконувати побудови тривимірних деталей 

та збірних конструкцій використовуючи програму КОМПАС-

3D. 

  

Теоретичні відомості 

Монтаж систем та технічних засобів автоматизації має на 

меті виконати всі роботи пов’язані зі встановлення обладнання, 

яке передбачено монтажними кресленнями проектованої 

системи автоматизації. Крім безпосереднього монтажу приладів 

у ці роботи включають прокладання з’єднувальних ліній та 

установку допоміжних пристроїв з опорними та кріпильними 

конструкціями. Тому важливим елементом проектування систем 

автоматизації є розробка монтажних креслень, які крім іншого 

містять: монтаж щитів і пультів, місцевих приладів, відбірних 

пристроїв та виконавчих механізмів. При цьому, 

проектувальник повинен врахувати всі особливості конструкції 

таких пристроїв і вказати їх на кресленнях. Наприклад, монтаж 

контактних термоприймачів (манометричні термометри, 

термометри опору, термопари) здійснюється так, щоб врахувати 

особливість теплообміну між термоприймачем і навколишніми 

стінками та врахувати відвід тепла в навколишнє середовище 

через елементи кріплення термоприймача. Виконання 

відповідних креслень, дає змогу врахувати всі особливості 

технічних засобів автоматизації, що у свою чергу впливатиме на 

ефективність роботи всієї системи. 

Також у сучасних системах автоматизації широко 

застосовуються технічні засоби елементами конструкцій яких є 

деталі поперечний переріз у яких змінюється за довжиною. 

Прикладами таких елементів є частини дозаторів, гідравлічні 

розширення або звуження, з’єднувальні фланці витратомірів, 

подаючий та всмоктуючий фланці насосів, захисні кожухи 

тощо. Для розробки таких елементів необхідно використовувати 

3D-моделі та збірні конструкції. 

У попередніх лабораторних роботах було детально 
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розглянуто можливість виконання тривимірних моделей та 

збірних креслень за допомогою програмних продуктів AutoCAD 

та Autodesk Inventor. У цій лабораторній роботі ми розглянемо 

приклади застосування програми КОМПАС-3D. Оскільки у 

різних версіях програми КОМПАС-3D процес створення 

тривимірних деталей та збірних конструкцій подібний, тому у 

цьому описі не вказано конкретну версію програми, яка 

використовувалася для виконання побудов, хоча деякі несуттєві 

відмінності між версіями все ж таки можуть спостерігатися.  

Для створення 3D-моделей у програмі КОМПАС-3D 

використовуються різноманітні операції переміщення плоских 

фігур (ескізу) у просторі. У різних версіях програми ескіз може 

розміщуватися на одній зі стандартних площин проекцій, на 

плоскій грані створеного раніше елементу або на допоміжній 

площині. Ескізи утворюються засобами КОМПАС-ГРАФИК і 

складаються з одного або декількох контурів. Після побудови 

ескізу необхідно застосувати одну з операцій для побудови 

об’ємних елементів, чотири з яких вважаються базовими: 

- «Операция выдавливания» – видавлювання ескізу 

перпендикулярно його площині; 

- «Операция вращения» – обертання ескізу навколо осі, що 

лежить в його площині; 

- «Кинематическая операція» – переміщення ескізу вздовж 

направляючої; 

- «Операция по сечениям» – побудова об’ємного елемента за 

декількома ескізами (перерізами).  

Крім того, вказані операції можуть мати додаткові 

можливості (опції), що дозволяють змінювати або уточнювати 

побудову об’ємного елементу. Наприклад, якщо при виконанні 

«Операция выдавливания» прямокутника задати величину і 

напрямок нахилу, то замість призми буде побудована зрізана 

піраміда. Тому процес створення 3D-моделі зводиться до 

багаторазового додавання і видалення додаткових елементів. 

Прикладами видалення об’ємів з деталі можуть бути 

різноманітні отвори, проточки, канавки, пази, а прикладами 

додавання об’єму: виступи, ребра та ін. 

Розглянемо приклад створення 3D-деталі типу фланець (рис. 
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3.1). Після запуску КОМПАС-3D в діалоговому вікні вибираємо 

тип документу «Деталь». 

 

 
Рис. 3.1. Зовнішній вигляд 3D-деталі типу фланець 

 

На початку створення 3D-деталі необхідно побудувати її 

ескіз. Для цього вибираємо площину в якій буде здійснюватися 

побудова. Потім, за допомогою «Дерево модели» (рис. 3.2, а), 

яке знаходиться у рядку «Начало координат» вибираємо одну із 

площин (XY, ZX, ZY) в якій буде здійснюватися побудова 

плоского ескізу (в даному випадку вибрана площина XY, на 

екрані вона підсвічується зеленим кольором і виділена жирним 

шрифтом). Після вибору площини стає активною команда 

«Эскиз» в рядку поточного стану (рис. 3.2, б), натиснувши на 

відповідну кнопку відбувається перехід до КОМПАС-ГРАФИК. 

 

   
а                                                  б  

Рис. 3.2. Меню «Дерево модели» та кнопка побудови ескізу 

 

За допомогою команд розділу «Геометрия» здійснюємо 

побудову ескізу, при цьому готовий ескіз може виглядати так, як 

показано на рис. 3.3. Дана деталь будуватиметься за допомогою 
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операції «Вращение», тому необхідно задати вісь її обертання 

(червона штрих-пунктирна лінія).  
 

 
Рис. 3.3. Вигляд ескізу деталі 

 

Після виконання усіх побудов у ескізі необхідно перейти до 

3D - моделювання шляхом повторного натискання кнопки 

«Эскиз» в рядку поточного стану КОМПАС-3D. Для створення 

об’ємного зображення необхідно виконати її обертання навколо 

осі натиснувши на кнопку «Операция вращения» (рис. 3.4, а). 

Після чого 3D-деталь набуде вигляду, як на рис. 3.4, б. 

 

   
а                                    б 

Рис. 3.4. Вид 3D – моделі після виконання «Операция вращения» 

 

Для побудови отвору на циліндричній поверхні необхідно 

вибрати площину в якій він буде розміщуватися (наприклад, 

ZX) і перейти до ескізу шляхом активації команда «Эскиз» в 

рядку поточного стану. Так, як прив’язки для новоствореної 

деталі не працюють, то необхідно спроектувати основу циліндра 

на цю площину. Для цього, на панелі команд вибираємо 

команду «Спроецировать объект» (рис. 3.5, а) і натискаємо 

лівою клавішою миші на відповідних гранях. За допомогою 



44  

допоміжної геометрії будуємо діагоналі утвореного 

прямокутника і на перетині будуємо коло основною лінією. 

Після проведених побудов ескіз (лінії синього кольору) набуде 

вигляду, як на рис. 3.5, б. 

Перед виконанням команди «Вырезать выдавливанием» 

необхідно видалити проекцію основи циліндра. Після цього, 

можна здійснювати вирізання отвору. В рядку параметрів 

задаємо «Обратное направление», «Через все» (рис. 3.6). 

Для виконання кінцевих побудов на площині фланця 

вирізаємо 6 отворів для болтового з’єднання. Спочатку робимо 

один отвір, а потім використовуючи команду «Массив 

элементов по концентрической сетке» створюємо масив з 

шести отворів. Активація цієї команди здійснюється на панелі 

команд, а потім в «Дерево модели» вибираємо Вырезать 

элемент выдавливания: N2», задавши у рядку параметрів 

кількість отворів - 6 (рис. 3.7) отримаємо кінцеву 3D- модель 

(див. рис. 3.1). Для виконання округлення відповідних стиків 

суміжних граней використовуємо команду «Скругление». 
 

  
а                                        б 

Рис. 3.5. Виконання проектування та побудови ескізу отвору на 

3D- моделі 

 

  
Рис. 3.6. Виконання команди «Вырезать выдавливанием» 
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Рис. 3.7. Виконання команди «Массив элементов по 

концентрической сетке» 

 

У розглянутому вище прикладі показано принцип створення 

3D-моделі на основі ескізів. Такий підхід можна 

використовувати для побудови 3D-деталей різної складності 

застосовуючи команди, які дають змогу редагувати розроблену 

модель. 

Для створення збірних конструкцій, які складаються з 3D-

моделей деталей, підзборок і стандартних виробів у програмі 

КОМПАС-3D необхідно зберегти всі 3D-моделі компонентів 

зборки у окремих файлах. Варто зауважити, що у файлі зборки 

зберігаються лише посилання на її компоненти.  

Розглянемо процес створення зборки на прикладі збірної 

конструкції «Блок направляючий» (рис. 3.8). Як було сказано 

вище, всі деталей зборки мають бути розроблені раніше. Крім 

того, ми розглянемо приклад процесу створення другої 3D-

деталі «Кронштейн» у контексті розроблюваної зборки. 

 

 
Рис. 3.8. Елементи зборки «Блок направляючий» 

 

Для створення файла зборки необхідно вибрати з меню 

«Создать» на панелі «Стандартная» тип створюваного 

документа «Сборка». Після цього, на екрані з’явиться вікно 

нової зборки, яку необхідно зберегти з відповідним іменем. Щоб 

додати в зборку окремий компонент, який вже є у вигляді 
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файлу, необхідно натиснути кнопку «Добавить из файла» на 

панелі «Редактирование сборки» (рис. 3.9). 

 

 
Рис. 3.9. Додавання нового компоненту в зборку 

 

Після вставлення компонента у зборку, його початок 

координат, напрямок осей і системні площини суміщаються з 

аналогічними елементами зборки. При цьому, перший 

компонент автоматично фіксується у зборці у тому положенні, у 

якому він був вставлений. Зафіксований компонент не може 

бути переміщений або повернутий у системі координат зборки. 

Потім потрібно додати у зборку 3D-деталь «Втулка» і 

розмістити її поряд з «Ролик», при цьому достатньо вказати її 

приблизне положення (рис. 3.10, а). Додані компоненти 

з’являться у «Дереве модели» (рис. 3.10, б) з присвоєними 

раніше іменами, які взяті з їх файлів.  

 

  
а                                                б 

Рис. 3.10. Додавання окремих 3D-деталей в зборку 

 

У розглянутому прикладі детально описано процес створення 

зборки з двох деталей «Втулка» і «Ролик». Процес створення 

зборки інших елементів конструкції «Блок направляючий» 

аналогічний, тому детальний опис його виконання у даному 

прикладі не подається.  

При додаванні компонента у зборку, проектувальник 

спочатку задає його попереднє положення, а потім визначає 
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точне розташування. Зазвичай це відбувається у два етапи: 

1. Уточнюється положення і орієнтація компонента шляхом 

його переміщення і обертання у просторі зборки.  

2. Визначається точне положення компонента шляхом 

спряження. 

Для переміщення компонента необхідно натиснути кнопку 

«Переместить компонент» (рис. 3.11) на панели 

«Редактирование сборки». При цьому курсор змінює свою 

форму. Встановіть курсор на деталь Втулка, натисніть ліву 

кнопку миші і, не відпускаючи, переміщуйте деталь у нове 

положення. Після цього кнопку миші відпускають (рис. 3.11, б). 

 

        
                        а                                                б 

Рис. 3.11. Переміщення компонентів зборки 

 

Для повороту компонентів використовують кнопку 

«Повернуть компонент» (рис. 3.12, а), при цьому курсор змінює 

свою форму. Встановіть курсор на деталі «Втулка», натисніть 

ліву кнопку миші і не відпускаючи її переміщайте курсор. 

Деталь буде повертатися навколо свого геометричного центру 

(рис. 3.12, б). 

 

 
                        а                                                б 

Рис. 3.12. Повертання деталі навколо геометричного центру 

 

Після попереднього розташування компонента, можна 
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приступити до задання його точного положення у зборці. Це 

досягається за рахунок формування спряжень між 

компонентами. Спряження – це параметричний звязок між 

гранями, ребрами, вершинами, площинами або осями різних 

компонентів зборки. Для того, щоб визначити положення деталі 

Втулка, потрібно задати два спряження. Натисніть кнопку 

«Соосность» на панелі «Сопряжения» (рис. 3.13). 

 

 
Рис. 3.13. Використання панелі для спряження деталі 

 

Для виконання спряження необхідно вказати циліндричні 

грані на деталях «Ролик» і «Втулка» (рис. 3.14, а). Положення 

деталі «Ролик» фіксується у просторі зборки, а деталь «Втулка» 

розвернеться так, що вказані грані стануть співвісні (рис. 3.14, 

б). Після цього, натисніть кнопку «Совпадение объектов» і 

вкажіть плоскі кільцеподібні грані на «Ролик» і «Втулка» (рис. 

3.14, в). При цьому, курсор повинен знаходитися в режимі 

вказівки граней, при виникненні проблем зі спряженням можна 

збільшити масштаб зображення, що допоможе виконати 

спряження. Після правильного виконання всіх дій деталь 

«Втулка» займе точне положення у зборці (рис. 3.14, г). 

 

             
   а                        б                         в                          г 

Рис. 3.14. Процес виконання «Совпадение объектов» 

 

Для того, щоб додати ці елементи до інших компонентів 

зборки, наприклад до «Вилки» їх потрібно розташувати поряд 

(перед цим додайте необхідні компоненти з файлу). Після цього 
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натиснути кнопку «Соосность» на панелі інструментів 

«Сопряжения» і вказати циліндричні грані елементів «Втулки» і 

«Вилки» (рис. 3.15, а). При цьому, «Ролик» потрібно 

розташувати точно між провушинами елементу «Вилка». Для 

цього потрібно сумістити їх площини. Далі потрібно натиснути 

кнопку «Совпадение объектов»  на панелі «Сопряжения» у 

«Дереве модели» відкрити гілку «Компоненты – Ролик – 

Системы координат – Начала координат» і вказати 

«Плоскость ZY». Потім розкрити гілку «Вилка – Системы 

координат – Начала координат» у вказати «Плоскость ZY» 

(рис. 3.15, б). Після цього збірна одиниця займе відповідне 

положення у зборці (рис. 3.15, в). Інші компоненти зборки 

додаються аналогічно до описаної послідовності. 

   
          а                                      б                                 в 

Рис. 3.15. Виконання спряження різних компонентів зборки з 

відображенням у «Дереве модели» 

 

Після виконання всіх спряжень потрібно натиснути кнопку 

«Прервать команду», потім «Перестроить» на панелі «Вид», 

після чого виконуємо зберігання використовуючи кнопку 

«Сохранить» на панелі «Стандартная». У результаті роботи 
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отримаємо збірну конструкцію, яка показана на рис. 3.16. 

 
Рис. 3.16. Кінцевий вигляд виконаної збірної конструкції 

 

Як було сказано раніше, розглянемо приклад створення 

окремої деталі зборки «Кронштейн», який використовується для 

кріплення всієї конструкції у середовищі розробки збірних 

конструкцій (див. рис. 3.16). Для цього, необхідно натиснути 

кнопку «Создать деталь» на панелі «Редактирование сборки» 

. Система перейде в режим створення  нової деталі. При 

цьому кнопки «Эскиз» і «Редактировать на месте»  на 

панелі «Текущее состояние»  будуть знаходитися у 

ввімкненому стані, а всі компоненти зборки будуть виділені 

кольором. У нашому випадку деталь «Кронштейн» точно 

відповідає основі деталі «Вилка». Тому для її додавання у зборці 

виконується за допомогою команди проектування об’єктів, яка 

активується натисканням кнопки «Спроецировать объект» на 

панелі «Геометрия» . Після цього, натискаємо кнопку 

«Прервать команду»  на «Панели специального управления» 

закрийте «Эскиз» і витиснути його прямому напрямку на 

відповідну відстань (30 мм) натиснувши на кнопку «Выдавить» 

. За подібним алгоритмом створюється опорна площина та 

інши елементи деталі «Кронштейн». 

Для того щоб завершити виконання монтажного креслення 

збірної конструкції і розробити його у відповідності до вимог 

Держстандарту необхідно перенести розроблену 3D-модель 

збірної конструкції на аркуші стандартного виду з оформленим 

основним написом. У програмі КОМПАС-3D, як і в інших 
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подібних CAD-системах, це можна зробити шляхом створення 

стандартних виглядів, перетинів та розрізів з вказівкою 

відповідних розмірів. Для того щоб розташувати розроблену 3D-

модель на аркуші стандартного виду необхідно створити нове 

креслення, наприклад формату А2 горизонтальної орієнтації, а 

відкриту 3D-модель «Блок направляючий» зберегти вказавши 

«Стандартные виды» на панелі інструментів «Ассоциативные 

виды». Після цього, на кресленні створити три стандартних 

вигляди, прийнявши за головний вигляд з орієнтацією праворуч. 

Також, потрібно вказати масштаби виглядів та ввімкнути 

«Отрисовку линий перехода поверхностей». У кінцевому 

вигляді отримаємо зображення подібно, як на рис. 3.17. 
 

 
Рис. 3.17. Монтажне креслення збірної конструкції виконане на 

стандартному аркуші 
 

Крім вказаних вище елементів створене таким чином 

креслення можна редагувати додаючи різноманітні додаткові 

види та розрізи, а також задаючи штрихування та інші необхідні 

деталі, які допоможуть виконати розробку та монтаж готового 

виробу. 



52  

Програма роботи 

1. Навчитись розробляти 3D-моделі та збірні конструкції 

використовуючи програму КОМПАС-3D. 

2. Виконати побудову 3D-деталей та креслень згідно 

заданого варіанту 

 

Порядок виконання роботи 

1. Частина 1. Розглянути способи побудови 3D-моделей у 

програмі КОМПАС-3D з теоретичних відомостей. 

2. Визначити монтажні параметри збірної конструкції 

витратомірного сопла за допомогою розрізу, що показаний на 

рис. 3.18, розміри окремих деталей (фланці, витратомірне сопло, 

вимірювальні патрубки) вибрати відповідно варіанту табл. 3.1, 

3.2 (за двома останніх цифрами номеру залікової книжки 

студента). 

3. Накреслити всі 3D-деталі збірної конструкції 

витратомірного сопла за допомогою “КОМПАС-3D” «Деталь», 

кожна 3D-моделей створюється окремо та зберігається у різні 

файли з відповідними назвами. 

4. Виконати перетворення кожної 3D-моделі збірної 

конструкції у креслення розмістивши на стандартному аркуші з 

оформленим основним написом.   

5. Частина 2. Розглянути способи побудови збірних 

конструкцій 3D-моделей у програмі КОМПАС-3D «Сборка» з 

теоретичних відомостей. 

6. Використовуючи розроблені та збережені 3D-моделі 

виконати їх об’єднання у збірну конструкцію використовуючи 

опцію КОМПАС-3D – «Сборка». 

7. Виконати перенесення розробленої 3D-модель збірної 

конструкції на аркуші стандартного виду використовуючи 

опцію «Новый чертеж из модели». 

8.  Результати проектування оформити у вигляді звіту на 

стандартних аркушах формату А4, а також надати виконані 

файли 3D- моделей для перевірки. До звіті необхідно додати 

креслення у трьох стандартних виглядах (спереду, збоку, 

зверху) та ізометрію на аркуші стандартного розміру (А4-А1) з 

розмірами та заповненим основним написом. 
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Рис. 3.18. Повздовжній переріз збірної конструкції витратомірного 

сопла: R1=0,4b, h1=0,2B1, h2=0,3B2, Н=D/2+4b, довжина 

витратомірного сопла вибирається довільно 

 

Таблиця 3.1 

Десятки 

у шифрі 

 
0 1 2 3 4 5 6 7 8 9 

B1, мм 47 35 50 45 40 45 50 55 60 65 

B2, мм 40 25 45 30 35 40 45 50 55 60 

D, мм 10 15 20 25 30 35 40 45 50 55 

d, мм 4 6 10 12 16 24 28 34 42 44 

 

 Таблиця 3.2 

Одиниці 

у шифрі 0 1 2 3 4 5 6 7 8 9 

b, мм 4 5 2 3 4 2 5 3 5 2 

b1, мм 2 4 3 3 2 4 4 2 2 2 

d1, мм 4 5 6 7 6 7 2 3 5 4 

d2, мм 3 4 5 3 4 5 5 3 4 4 

 

 

Контрольні запитання. 

1. Яка особливість розробки монтажних креслень при 

проектування систем автоматизації. 

2. Які операції переміщення плоских фігур (ескізу) у просторі 

використовуються у програмі КОМПАС-3D? 
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3. Розкрийте послідовність створення 3D-деталі у програмі 

КОМПАС-3D? 

4. Який підхід використовується на початку створення збірних 

конструкцій у програмі КОМПАС-3D? 

5. Як відбувається додавання, переміщення та спряження 3D-

деталей в зборці? 

6. Як відбувається створення окремої деталі у вже існуючій 

зборці? 
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Додаток 1 
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